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Before Getting Started 
 Your objective is to implement quality assurance on 2011-2014 stream temperature data. 

 In some cases, quality assurance was conducted on data from 2011-2013.  In these cases, quality 

assurance will need to be conducted on the 2014 component of the data. 

 In 2011 (panel year 1), stream temperature was only measured at annual sites; in 2012 some 

groups placed temperature probes in panel year 1 and 2 sites. There are exceptions to this.  The 

basin supervisor should be aware of when and at what sites probes were placed. 

 The recommended workflow is to review one site at a time, across all years. 

 Before getting started, consolidate all paper data forms and field notes with temperature probe 

information along with the probes that have been removed from streams (hopefully they are 

labeled with a Site ID and removal date). 

 This QA process will require some ‘detective work’.  Use all available sources of information: 

paper forms, logger files, details on HOBOware plots, photos, and past employees.  Scrutinize 

information carefully; it may be fragmented, erroneous, or missing. 

 Important steps in temperature probe management are: installation, habitat survey visit, and 

probe download.  Because the data logger (i.e. Allegro/iPad) application has a stream 

temperature table, crews (almost) always made a record regarding the probe while sampling.  

This may or may not be true of the installation and download.  These tasks are often done 

without a data logger and may be documented on paper, or not at all. 

 Stream temperature data from some watersheds, particularly those with large, cold rivers and 

stable flows, won’t have many or any anomalies.  In contrast, data from other watersheds, 

especially those with warm air temps, small streams, and fluctuating flows, will have many 

errors. 

 Create a ‘2014 temperature To Do’ document.  During this QA process you will likely become 

aware of issues and things to take care of next field season.  For instance, you may discover that 

a probe is malfunctioning and that it needs to be replaced. 
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Part 1: Validating Metadata 

Verify Stream Temperature Logger Metadata 
The primary goal of this step is to verify that the full record of temperature files has been uploaded and 

that deployment period information is being correctly used to trim pre- and post-deployment 

observations before the stream temperature data are plotted as a complete time-series.  Prior to 

reviewing metadata and conducting QA, make sure that all available temperature data files downloaded 

in 2014 have been published via the CHaMP laptop Data Broker. 

Metadata for stream temperature data are populated using information collected on the data logger 

and stored in two tables: 1) Stream Temperature Logger, and 2) Stream Temperature Logger 

Maintenance.   

Three key pieces of information in the stream temperature tables are used to trim the dataset and 

ensure proper upload to CHaMPMonitoring.org (CM.org).  Therefore, at the start of the stream temp QA 

process, it is crucial for crew supervisors or leads to check the completeness and accuracy of the 

following: 

Logger ID  Logger ID should match the manufacturer’s serial number for the probe(s) that 

was installed at the site (not the Site ID). 

Date Installed  Date installed reflects the actual date the probe was installed in the stream. 

Date Removed  Date removed is filled out for any probe that was removed/replaced by a new 

probe. 

Temperature files that have been downloaded from probes in the field and uploaded to CM.org can be 

found in the Stream Temperature Results File table. Check the completeness of the following (see Part 3 

for more details): 

Plot Title   Plot Title must include the Logger ID; is exported by HOBOware to the .csv file. 

After Auxiliary data have been uploaded to CHaMPMonitoring.org (CM.org), the temperature metadata 

tables can be reviewed and edited.  Steps to access and edit this information are presented in the next 

sections. 
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Stream Temperature Logger table 

The Stream Temperature Logger table (Figure 1) displays all temperature loggers that have been 

installed at a site from 2011-2014. 

 

Figure 1. The Stream Temperature Logger table provides an inventory of sites with loggers; the Site ID 

column is circled. 

To locate the Stream Temperature Logger table: 

1. From the Watersheds menu, select your watershed 

2. Select the Measurements tab. 

3. Go to the Auxiliary Data tab. 

4. From “Measurement Type” drop down, select “Stream Temperature Logger”. 

a. Select the year of interest from the dropdown menu on the upper right. 

b. All values in blue text can be edited. 

c. If you make edits, make sure to click “Save Changes” or they will be lost. 

d. To navigate to an individual site from this table, hold the Ctrl key while clicking the SiteID 

link; a new browser window will open with that site’s Site Detail page. Alternatively, you 

can filter out a site by entering the individual SiteID number in the space under the SiteID 

column heading. 

5. Read the “Field Notes” column.  There may be information that will help make sense of 

confusing scenarios.  For example, “probe was downloaded and placed into another site”, is a 

vital piece of information. 

6. Sort the Logger ID field.  Ensure that Logger ID is not null, does not equal 1, 9999, -9999, etc.  

a. The ID should have seven or eight digits. If the probe is a TidbiT provided by CHaMP in 

2011, the Logger ID will have seven digits and begin with 99.  TidbiTs provided by CHaMP 

from 2012-2014 begin with 10 and have eight digits. 

b. Look for duplicates.  Duplicates may or may not be valid; investigate and make sure the 

circumstance makes sense. 

https://www.champmonitoring.org/Watershed/ListWatersheds/1
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c. Ensure that the Logger ID matches the manufacturer’s serial number for the probe that 

was installed at the site (not the Site ID). This step should have been completed in the 

field if the probe was left in place after download. 

i. The serial number can be validated using HOBOware software (see Part 2 of this 

document). 

ii. The ID may have been validated in the field 1) during installation, 2) via a maintenance 

record, 3) during download, and/or 4) when the probe was removed. 

iii. Was any of the temperature probe data (i.e. serial  number, date installed) collected 

on paper?  Transcription errors are common; ensure the information was entered 

correctly. 

iv. If the probe was removed, it should have a label attached to it indicating the site it 

was in. 

7. Review/Ensure that the “Date Installed” is correct. 

a. This date is used to trim temperature data. 

b. Were probes installed when the site was sampled, or during a scouting hitch? 

c. Did technicians have a data logger when probes were installed, or was information 

recorded on paper?  Double check values recorded on paper. 

d. You will have another opportunity to validate the installation data when you examine data 

using the QA tool (Part 4 of this document). 

8. Review the “Date Removed” column. 

a. Why was the probe removed? 

b. If you have the removed probe in your office, validate that the manufacturer’s serial 

number matches the Logger ID in this table.  If the removed logger has other information 

(tag indicating the site it was taken from, and date), validate that, too. 

9. Add additional probes if necessary.  This occurs when a probe was installed without using the 

data logger.  To add a probe, go to the Site Detail page. 

a. To navigate to a Site Detail page of interest, hold the Ctrl key while clicking the SiteID link; 

a new browser window will open with that site’s Site Detail page. 

b. Go to Measurements tab. 

c. Go to Auxiliary tab. 

d. From “Measurement Type” drop down, select “Stream Temperature Logger” 

e. Use the “Add New Record” button in the lower left corner of the grid. 
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Stream Temperature Logger Maintenance table 

1. From Watersheds menu, select your watershed 

2. Go to Measurements tab. 

3. Go to Auxiliary tab. 

4. From “Measurement Type” drop down, select “Stream Temperature Logger Maintenance” 

Note: there isn’t temperature maintenance data for 2011 sites. 

5. Verify that Date and Time are filled out correctly 

6. If files were downloaded, set the “Downloaded” field to “True" 

7. Sort the “Sensor Condition” column.  Investigate any records which are not “In Flowing Water”.  

If probes aren’t in flowing water, their data will need to be trimmed (see Part 4). 

8. Sort the “Action” column; investigate records that aren’t "Left in Place”. 

9. If instantaneous temperature was recorded in the field, be sure to add it to the maintenance 

record. 

10. If additional maintenance records need to be added, go to the Site Detail page (Figure 2). 

11. From the Site Detail page, select the desired visit from the drop-down in upper right corner. 

12. Go to Measurements tab. 

13. Go to Auxiliary tab. 

14. From “Measurement Type” drop down, select “Stream Temperature Logger Maintenance” 

15. Click the “Add New Record” button in the lower left corner of the grid.  

 

 
Figure 2.  Adding a new maintenance record.  Transcribe the download time and instantaneous 

temperature from paper data forms and field notes. 

  

https://www.champmonitoring.org/Watershed/ListWatersheds/1
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Part 2: Uploading Stream Temperature Data 
Stream temperature data may be uploaded using the CHaMP Data Broker or directly to CM.org.  This 

section includes instructions for uploading stream temperature data directly to CM.org.   If a probe was 

downloaded when the habitat survey was conducted, the data upload likely occurred via the laptop 

Data Broker.  Instructions for data upload via the Broker are available on CM.org in the file “Laptop Data 

Broker – Publish Data Set Components.pdf” 

 Note: If you have already uploaded all of your temperature files, skip this section and proceed to Part 3. 

Prepare .csv and .hobo Files for Upload Using HOBOware 
1. Create a folder on your desktop for temperature files.  Use a naming convention similar to this: 

“2013 Yankee Fork Stream Temp Archive”.   After all your files have been uploaded, archive this 

folder. 

2. Open HOBOware pro software. 

3. It is recommended to leave all default setting for the HOBOware software. The default setting is 

to export “Text (.txt or .csv)”, and Export table data column separator to “Comma”. 

4. Open the site of interest: 

a. Using HOBOware: File\Open Datefile(s) 

b. My Documents\HOBOware\ShuttleReadout… 

c. C:\Users\champ\My Documents\HOBOware\ShuttleReadout… 

5. Examine the HOBOware plot. 

a. In HOBOware, first make sure that the temperature values are displayed in degrees 

Celsius.  This can be done by selecting the dropdown in the menu bar to display “SI” units. 

b. Examine the ‘Details’ window on the left side of your temperature plot. 

c. Manufacturer’s serial number / Logger ID is visible under the “Device Info” tab (Figure 3). 

d. Compare the Logger ID in the plot title with the ID listed in the “Stream Temperature 

Logger” table on CM.org.   

6. Check that the “Plot Title” matches or contains the manufactures serial number (e.g. “Logger 

ID”). It is recommended to leave all default setting for the HOBOware software, including plot 

title. This will set the “Plot Title” to be the manufactures serial number. Modifying the plot title 

is not recommended. However, if the plot title is modified, then it must include the 

manufactures serial number. 

a. If the Plot Title does not contain the manufacturer’s ID: 

i.  Double click the Plot Title; the “Title Properties” window opens. 

ii. Enter the manufacturer’s serial number into the chart title. 

iii. Click “Apply”, then “Done”. 

https://www.champmonitoring.org/Program/RetrieveProgramDocumentFile/1/324
https://www.champmonitoring.org/Program/RetrieveProgramDocumentFile/1/324
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Figure 3. The manufacturer’s Logger ID\serial number and the last sample time are visible in the Details 

window of HOBOware pro. 

7. Choose File > Export, or click the Export icon on the toolbar:   

a. The Export Options window appears; click Export. 

b. Save it to folder you created in step 1 above, using this naming convention: 

i. (SiteID)_(manufacturers LoggerID)_ (date in “YYYYMMDD” format) 

ii. Ex: CBW05583-000851_10148966_20141009.csv 

8. Copy and paste the associated .hobo file into the same folder 

9. The .hobo file is located here: C:\Users\champ\My Documents\HOBOware\ShuttleReadout… 

10. IMPORTANT: Rename the .hobo file with the same name as the .csv file.  The easiest way to do 

this is to copy and paste the .csv file name. 

11. Select both files, right click, then select: Send to \Compressed (zipped) folder. 

12. Files are ready for upload. 
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Renaming a HOBOware Plot Title using NotePad 

There are two ways to enter the manufacturer’s serial number in the Plot Title, in HOBOware (before 

the .csv file is created – described above) or using NotePad (after the .csv is created).  To change the Plot 

Title in Notepad: 

1. Open the .csv file using NotePad or other text editor.  DO NOT use Excel!! 

2. Change the Plot Title in the first row, without deleting quotations or commas 

3. Save the file while the file is open 

4. Close NotePad without saving as a new file 

5. Upload the modified file as described above 

Manage Stream Temperature Files Directly in CHaMPMonitoring.org 
1. From Watersheds menu, select your watershed. 

2. Select Field Support tab. 

3. Go to Data Check In tab. 

4. Click the blue cloud icon in the left-most column (Figure 4).  Make sure you are selecting the 

correct visit; 2014 data should be uploaded to the 2014 visit (not 2012, 2013, or 2014). 

- Note: your account must have crew member, watershed QA lead, or watershed manager 

permissions. 

5. The File Management dialog box will open.  From the dialog box, select “Stream Temp Readings” 

from the “Type” dropdown menu (Figure 5). 

Figure 4. The blue icon (circled in red) beside the site of interest is clicked to manage stream 

temperature data directly to CHaMPmonitoring.org. 

 
Figure 5. “File Management” dialog box.  Select “Stream Temp Readings” from the “Type” dropdown. 

https://www.champmonitoring.org/Watershed/ListWatersheds/1
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6. To upload new files, click “Upload New Files” 

a. Click “Choose File”, browse to the zip file, and click open. 

b. Review the summary of the files to be uploaded. 

c. Click the “Process” button, then “Save”. 

d. You will see a green check indicating changes were saved.   

e. Files will be uploaded and processed in approximately two hours. 

7. If files were previously upload, they will be listed in the dialog box (Figure 6) 

a. The file can be download with the blue download arrow  

b. The file can be renamed with the pencil icon  

c. The file can be delete with the red minus icon  

 
Figure 6. Display of uploaded files list and file management options (circled in red) 

Special circumstance:  You may have more than one temperature file for a probe within a one year 

period.  This could happen if a probe was downloaded in the spring before runoff and again in the fall.  If 

this occurs: 

 You will have a (zipped) pair of .csv / .hobo files from each download. 

 The file names should reflect the different download dates 

o ‘000851_10148966_20130522.zip’ contains files from a May, 5th 2013 download 

o ‘000851_10148966_20131009.zip’ contains files from an October 10th, 2013 download 

 Upload zipped files separately. 
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Part 3: Validating the Stream Temperature Results File 

Verify that Temperature Files were Successfully Uploaded  
1. Select your watershed from the Watersheds menu. 

2. Go to Measurements tab. 

3. Go to Stream Temp Data tab. 

4. Select “Stream Temperature Result File” from the “Measurement Type” drop down. 

5. Look for blanks in the “Logger ID” and “Plot Title” fields (Figure 7). 

 
Figure 7.  The third Plot Title does not contain a manufacturer’s serial number; therefore, the data did 

not upload. 

6. If you attempted to upload a .csv file that did not include the manufacturer’s serial number in 

the Plot Title(Figure 7): 

a. Open the .csv file from your archive in NotePad. Do not use Excel! 

b. Modify the Plot Title so it includes the Logger ID. 

c. Upload the corrected file.  The file name MUST BE the same as the original upload! 

d. Note: this error can be avoided by correctly exporting and naming files from HOBOware 

(See ‘Prepare .csv and .hobo Files for Upload Using HOBOware’ section in Part 2) 

  

https://www.champmonitoring.org/Watershed/ListWatersheds/1
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Verify that Temperature Files Align with Logger Metadata 
After temperature data has been uploaded, verify that the temperature files you uploaded align with 

metadata from the data logger.  

1. Open the “Stream Temperature Result File” table (Figure 8).  

2. Examine the “Min and Max Observation Date” columns.  These are the min and max date values 

in the .csv file.  If there is a missing date range, be sure that the .csv file uploaded correctly. If 

the file uploaded correctly, investigate to determine why data is missing for those dates (i.e., 

probe was lost, previous .csv files have not been uploaded). 

3. Review the “Recorded Date In/Out” columns. 

 

 

Figure 8.  Recorded Date In/Out dates are used to trim temperature data.  Data outside this range is 

indicated by “Has Observations Outside Logger Dates” column. 

a. If “Recorded Date In” is empty, go back and verify that; 

i. “Logger ID” is contained within “Plot Title” 

ii. “Date Installed” was entered in the Stream Temperature Logger table. 

b. If the temperature file has observations outside of the deployment period, then the 

column “Has Observations Outside Logger Dates” will be set to TRUE. 

c. Review the “Count Of Observation Before Date In” and “Count Of Observations After Date 

Out” columns. These hourly observations will be excluded (“trimmed”) from the time-

series graph. 

4. To review the observations that are being trimmed as a result of the deployment period: 

a. In the table, look at the column “Has Observations Outside Logger Dates” 
i. If that is true, then observations are being trimmed and the count is 

reported. 
ii. If that is false, then no observations are trimmed.  

b. From the left most column in the table, click the graph icon. 
c. All values that are outside of the deployment period for a file will be plotted in red 

(See Part 4, View Records Being Trimmed; Figure 14).  
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Part 4: Using the Stream Temperature QA Tool 

Set Watershed Thresholds for QA Flags 
The QA thresholds for stream temperature define which temperature values will be flagged as 

anomalies.  Flagged data will not be included in metric calculations.  The QA thresholds can be set to 

accommodate the unique climatic and geomorphic conditions of each watershed.  We recommend 

evaluating many sites with these default values before modifying thresholds. 

To access thresholds: 

1. From Watersheds menu, select your watershed. 

2. Go to Overview tab. 

3. Go to Characteristics tab. 

4. Review the Stream Temperature Quality Assurance Thresholds (Figure 9). 

 

Figure 9.  Default stream temperature quality assurance values on CM.org. 

 Thermal Minimum - Minimum allowed stream temperature within the watershed. All hourly 

values below this will be flagged 

 Thermal Maximum - Maximum allowed stream temperature within the watershed. All hourly 

values above this will be flagged 

 Hourly Variation - Maximum allowed difference between two consecutive hourly 

measurements.  If the difference between two consecutive hourly measurements exceeds this 

value, the second hourly measurement will be flagged 

 Daily Mean Variation Threshold - Maximum allowed difference between two consecutive daily 

mean temperatures. if the difference between two consecutive daily mean temperatures 

exceeds this value, all hourly values from the second day will be flagged 

https://www.champmonitoring.org/Watershed/ListWatersheds/1
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 Daily Max Variation Threshold - Maximum allowed difference between two consecutive daily 

maximum temperatures.  If the difference between two consecutive daily maximum 

temperatures exceeds this value, all hourly values from the second day will be flagged 

 Daily Range Threshold -Maximum allowed difference between the daily max and daily mean.  If 

the difference between the daily max and daily min (highest and lowest values within a day) 

exceeds this value, all hourly values from that day will be flagged 

 Daily measurement count threshold - Minimum number of measurements per day.  If the 

number of measurements per day is below this threshold then all hourly values from this day 

are flagged 

 Combine Anomalies within x hours - Number of hours which will be considered when 

determining separate anomalies.  If >1 anomalies occur within an x hour period they will be 

flagged as one anomaly  

QA Tool Basics 
Familiarize yourself with the tool before conducting QA.  Use the QA tool to check EACH site with 

temperature data. 

1. From Watersheds menu, select your watershed. 

2. Select the Visits tab and then select the site of interest. 

3. Select the Stream Temperature tab. 

4. Go to the Chart tab. 

 

Figure 10.  Temperature QA Tool components: A) Site ID, B) zoom tab options, C) slider tool, D) anomaly 

navigator, E) anomaly statistics, F) anomaly message, G) “Add Decision” to anomaly button, and H) 

“Display Series” window.   Hold your mouse over the plot to view the instantaneous temperature of a 

date/time (I).  To view temperature data from nearby sites (all sites in the same HUC 6), click one or 

more Site ID’s from the “Display Series” window (H). 

https://www.champmonitoring.org/Watershed/ListWatersheds/1
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Note: The ‘Grid Tab’ has info that is valuable for ‘detective work’ when investigating anomalies.  This tab 

includes the following information: Stream Temp Files, Probe Messages, Anomalies, Monthly Summary, 

Daily Summary, 8 Day Summary. 

How Anomalies are Displayed 
Each time a temperature record exceeds one of the thresholds set for the watershed, the record is 

flagged and identified as an anomaly. It is the job of the reviewer to examine each anomaly and 

determine whether that anomaly represents actual stream temperatures and should be passed, or the 

records are erroneous and should not be included in any of the stream temperature summaries. 

In the example below (Figure 11) an anomaly occurred between 1:00 and 2:00, the “hourly variation 

(was) greater than expected”.  Notice however, that the time period being flagged is NOT 1:00 to 2:00, 

but rather 2:00 to 3:00 (Figure 12) which has a very small hourly variation.  Keep this ‘one hour display 

lag’ in mind when performing QA. 

 

Figure 11. Stream temperature anomaly flagged by the QA tool.  The ‘Statistics’ information indicates 

the anomaly is one hour in duration.  The ‘Time Period’ indicated is 2:00 pm. 
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Figure 12. The “hourly variation greater than expected” anomaly occurred from 1:00 to 2:00, but the 

following hour is flagged by the QA tool. 

Adding a Decision to Each Anomaly 
You are required to review each anomaly and determine whether that data will be ‘passed’ or ‘rejected’.  

Rejected data will not be used to calculate metrics; however it will be saved within the database.  The 

following information is provided or each anomaly and can be used to determine its magnitude, 

duration, and type (D, E, and F in Figure 10): 

 Number of hourly measurements associated with each anomaly 

 The min, mean, and max temperature of the anomaly 

 Message describing each anomaly 

To add a decision to an anomaly:  

1. Select ‘Add Decision’ button 

2. A new window will pop up (Figure 13) 
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Figure 13.  “Add Decision” window of the QA tool.  Determine if the data will be Passed (summarized) or 

Rejected.  Include a comment explaining your decision. 

3. Select “reject”, or “pass” accordingly. 

4. Include a comment indicating the issue and resolution; this information will be invaluable for 

justifying why data was or wasn’t trimmed. 

5. Click start/end times/dates to adjust them to cover the appropriate time period of the anomaly 

(Figure 12). 

6. Once a decision has been applied to an anomaly, review, investigate, and apply a decision to the 

remaining anomalies at a site. 

7. You can apply a new decision ‘on top of’ a previous one.  The new decision will overwrite the old 

one; it does not need to match the same start and end date range.  If the user decided to reject 

a range of observations and then later decided to pass a portion of those formerly rejected 

observations, a new decision would be added for the observations that the user wanted to pass. 

Workflow Recommendations 
 The recommended workflow is to review one site at a time across all years. 

 To become familiar with a site's temperature data, start at the earliest period of record and scan 

the data in the chart to the end of the period of record.   A window of one month is suggested 

for this coarse review. 

 Compare data to “Nearby Sites” using the QA tool. 

 When scanning the data, make note of any date/time that appears suspicious and that may 

require a closer look during the anomaly review.  Note that there may be anomalies within the 

time series that are not flagged by the QA thresholds. 
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 Review each anomaly for the site.  Use the examples below to determine how each anomaly 

may have occurred and the appropriate resolution of the anomaly. 

 This process will require some ‘detective work’.  Use all available information: paper forms, Field 

Notes from the Logger table, details on HOBOware plots, photos, and past employees.  

Scrutinize information carefully; it may be fragmented, erroneous, or missing. 

 It will be helpful to have multiple CHaMPmontioring.org windows open: 

o Stream Temperature Logger 

o Stream Temperature Maintenance 

o Stream Temperature Results File 

o Temp QA Tool for the site on interest 

 Remember: hold the Ctrl key while clicking a SiteID to open a new browser window with that 

site’s Site Detail page. 

View Records Being Trimmed via the Deployment Period 

1. From Site Detail Page, click “Stream Temperature” tab 

2. Go to the “Grid” tab 

3. Select Measurement Type “Stream Temp Files” 

4. In the table, look at the column “Has Observations Outside Logger Dates” 

a. “True” indicates observations are being trimmed; the count is reported 

b. “False” indicates that no observations are being trimmed 

5. From the left-most column in the table (circled in red in Figure 14), click the graph icon. 

6. All values that are outside of the deployment period for a file will be plotted in red (Figure 14). 

7. Zoom in using the slider tool and determine if the “Recorded Date In” / “Recorded Date Out” 

should be adjusted to include/exclude more data.  

 

Figure 14. By clicking the graph icon in the far-left column (circled in red), a plot opens that displays the 

observations that are being trimmed in red.   



CHaMP 2014 Stream Temperature QA Protocol – October 8, 2014 

Prepared by CHaMP staff for Bonneville Power Administration 18 
 

Part 5: Types of Anomalies 

Partial Day Anomalies 

 There will be two partial day anomalies for nearly all plots.  These anomalies result from the first 

and last days of the record having less than 24 hourly measurements per day (Figure 15). 

 These anomalies do not necessarily represent errors 

 Review the data and determine if it should be ‘passed’ or ‘rejected’ 

 Reject the data from these days if it deviates from the pattern of the past/prior days’ data 

 

Figure 15.  Example of a temperature anomaly in which the temperature logger was downloaded before 

all 24 hourly measurements were recorded.  In these cases, the anomaly is accepted as good data. 

Installation/Removal Date Anomalies: Probe out of Water 
 This error occurs when a logger collected data before it was installed or after it was removed 

(Figure 16). 

 The installation/removal dates weren’t entered, or weren’t entered correctly. 

 When a logger is put in a stream the temperature usually drops and has a much smaller daily 

fluctuation than when it was in the air (in someone’s backpack or the back of their truck). 

 Refer to installation dates from the Stream Temperature Logger Table and visual fluctuations in 

the graph to determine the range of the anomaly that should be passed/failed. 

 The installation/removal dates can be edited in the Stream Temperature Logger table if 

necessary. 

Otherwise, use the “Add Decision” window to reject measurements where the probe was out of the 

water.   
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Figure 16.  Example of a temperature anomaly in which the temperature logger was removed from the 

stream but the logger was not downloaded and stopped until two days later.  The data plotted in orange 

represent air temperatures and should be rejected. 

Temperature Logger Partially, or Completely Out of the Water 

 When a probe is exposed to air it will deviate from ‘normal’ daily pattern.  It will usually have 

more extreme daily fluctuations (Figure 17).  Depending on the time of year the average 

temperature may increase or decrease. 

 Use all available information to determine if and when the probe when dry. 

o Stream Temperature Logger Maintenance table: was condition anything than “In Flowing 

Water”?  Was an hourly measurement recorded during download? (Figure 18). 

o Stream Temperature table: read Field Notes 

o Sampling photos: compare water conditions in the sampling photos to the data.  Does the 

stream look like it was going dry?  What was the sample data compared to when the 

‘weird’ data started? 

o The stream could have gone dry, or just the probe.  Examine the probe photo.  If the 

probe placement is too high, make a comment in your ‘2014 Temperature To Do’ 

document indicating the probe should be moved. 
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Figure 17.  Example of a temperature anomaly in which the temperature logger was out of water at the 

time of download.  Data highlighted in orange indicates the approximate range of data where the logger 

was recording air temperature and should be rejected, i.e. data recorded after 10:00 pm on July 22nd.  

 

Figure 18.  A spike in temperature (red) caused by a probe recording an hourly measurement when it 

was being downloaded.  “Reject” the spike and “Pass” the data before and after it (green/yellow). 

Temperature Logger Buried in Streambed Sediment 
 A buried probe often has smaller daily fluctuations and a lower average temperature than 

normal in-stream averages.  Probes can be buried suddenly after a major event (landslide, fire, 

etc.), or more slowly due to sedimentation. 

 Use all available information to determine if and when the probe became buried. 

o Examine records in the stream temperature logger maintenance table to see if there are 

any records with a probe status of ‘buried in sediment’? 

o Does the stream contain a high amount of fine sediment?  Probes are more likely to 

become buried in streams dominated by fine sediment.  Review the metrics of pool tail 

fines less than 2mm (high if lots of fines) and D16 values (low if lots of fines) to help 

determine if a site has a high likelihood of buried probes. 
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o What was the attachment method listed in the Stream Temperature Logger table?  Cable-

attached probes sit on the stream bed and are more likely to become buried. 

o Examine photo of probe by clicking link.  Is there a large sediment load?  Examine other 

sampling photos. 

 These types of anomalies are difficult to identify and flag using the QA thresholds in CM.org.  

Notice that the data in Figure 19 were not flagged.  Look for unusual patterns in the data such as 

unexpected declines in temperature and/or reduced variability in hourly temperature 

measurements to indicate a probe has been buried in the sediment.  Compare data to Nearby 

Sites using the QA tool. 

 Once the estimated logger burial start/end date has been determined, adjust the anomaly dates 

and reject the data. 

 

Figure 19. Example of a temperature anomaly in which the temperature logger was buried in sediment.  

Note the relatively steep decline in temperature after July 30 and reduced variation in hourly 

temperature.  See Figure 20 for comparison to a nearby temperature logger. 
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Figure 20. Hourly temperature data from a site near the buried temperature logger.  Note the more 

gradual decline in temperature after July 30 and the higher variation in hourly temperature throughout 

the measurement period. 

Device Failure 
 Sometimes a temperature logger will record a spike in temperature that is obviously outside the 

range of the normal stream temperature pattern (Figure 21). The cause of these device failures 

is unknown. 

 Reject the data from data spikes. 

 

Figure 21. Example of temperature anomalies in which the temperature suddenly spiked to over 100 °C 

and below -50 °C on two separate occasions. The cause of these blips in the temperature record is 

unknown, but appears to be device failure.  Data highlighted in orange are erroneous and should be 

rejected. 
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Dramatic Weather Events 
 Not all suspect data is erroneous.  Sometimes sudden weather events, like temperature drops or 

rainstorms may result in suspicious stream temperature data (Figure 22). 

 Examine nearby/similar sites (using “Nearby Sites” button in QA tool).  Do neighboring sites 

show the same pattern?  Use the weather, local discharge data, and local air temperature data 

to identify extreme weather events.  A comparison of streamflow and water temperature at the 

time of the event is shown in Figure 23. 

 If an anomaly is caused by extreme weather events, pass the data. 

 

Figure 22.  Example of a temperature anomaly, e.g., an increase in streamflow and decrease in air 

temperature, caused by a sudden / extreme weather event.   

 

Figure 23. Comparison of streamflow (cfs) measured in the Grande Ronde River at Perry and water 

temperature in Meadow Creek (site CBW05583-335162), its tributary.  Note that the drop in max daily 

water temperature corresponds to the sudden increase in streamflow on July 14-15. 
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Logger Shuttle Errors 
 If the date/time on the shuttle is not properly synched with the computer, erroneous dates are 

recorded for each temperature measurement and the data is useless (Figure 24). 

 This error can occur when you change the shuttle’s batteries in the field without synching to a 

laptop. 

 All data with incorrect dates should be rejected. 

 

Figure 24.  Example of a temperature anomaly in which the date/time on the Hobo shuttle was not 

synched with the computer prior to launch and/or download of the temperature logger.  In this case, all 

temperature records had an erroneous date/time of 01/01/1970 12:00 AM. 
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Part 6: Finalize Data, Ensure all Records Have Been Reviewed, and 

Examine Summarized Data 

Finalizing Data: Setting the QA Status 
1. Set the QA status after you’ve reviewed and made decisions for all anomalies. 

2. Select Visits tab. 

3. Select Measurements tab. 

4. Select Auxiliary Data tab. 

5. Select the Measurement Type of Stream Temperature Logger (Figure 25). 

6. Assign a QA rating, the options are: 

a. Not Assessed (default) 

b. Pass 

c. Does Not Pass 

d. Data Not Available  

7. Assign the appropriate QA Rating and add Comments as needed.  Comments are especially 

important if data ‘Does Not Pass’. 

8. Save the edits. 

 

 

Figure 25. Setting the QA Rating. 
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9. Repeat these steps to also rate the following tables: 

a. Stream Temperature Maintenance table:  accessed by selecting them from the 

“Measurement Type” dropdown. 

b. StreamTempOutput table:  accessed by Visits tab/Measurements tab/QA Status tab/select 

StreamTempOutput from the dropdown (Figure 26) 

 
Figure 26.  Display of QA status, accessed by selecting “Stream Temperature Logger” from the 

“File” dropdown menu. 

10. Not all data within the StreamTempOutput has to 'pass' QA in order to 'pass' the table.  

However, all anomalies must be reviewed and a decision must be made for each one. 

11. Once the ratings of a site are complete, QA Ratings can be reviewed by navigating to the QA 

Status tab of a site, as well as the QA Status tab of the Watershed page. 

12. We recommend setting the QA Ratings of the tables for stream temperature data AS YOU GO 

through sites in order to keep track of which sites have been QAed.  If this is done, the 

Watershed page review of QA Status ratings can be used to filter sites that do not yet have QA 

Ratings for Stream Temperature tables. To do this, filter the column “File” by Stream 

Temperature Logger and the column “QA Rating” by “Not Assessed" (Figure 26). 

Make sure all sites have been reviewed / passed 
1. From Watersheds menu, select your watershed. 

2. Select the Measurements tab. 

3. Go to the  QA Status tab. 

4. Scroll right to the “File” column, and select “Stream Temperature Logger” (Figure 25). 

5. Select “Not Assessed” from the “Rating” column. 

6. This is a list of sites that have not been QAed. 

Note: this will only work if you assigned QA ratings after EACH site was reviewed (we 

recommend this!). 

7. Check to see if sites with QA ratings of 'Not Assessed' had temperature loggers installed.  To do 

this, go to the Watershed level view of the Stream Temperature Logger table. 

8. Continue QA on any site with a logger that has not had the QA Status set. 

https://www.champmonitoring.org/Watershed/ListWatersheds/1
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Review Stream Temperature Summary Statistics 
Summarized stream temperature data is also available on CM.org.  These summaries may be useful 

when conducting ‘detective work’.  For example comparing the daily average and daily minimum 

temperatures of two neighboring probes may reveal suspect discrepancies. 

To view summarized temperature data: 

1. From Watersheds menu, select your watershed. 

2. Go to Visits tab and select your site of interest. 

3. Go to Stream Temperature tab. 

4. Go to Grid tab. 

5. From the “Measurement Type” dropdown menu, select: Monthly Summary, Daily Summary, or 

7 Day Summary. 

https://www.champmonitoring.org/Watershed/ListWatersheds/1

